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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Processors

Intel® Core™2 Duo processors

Computer models
equipped with
GLE960 system
board

Computer models
equipped with
GME965 system
board

●

T5670 1.80-GHz processor, 2-MB L2 cache,
800-MHz front side bus (FSB)

√

●

T5470 1.60-GHz processor, 2-MB L2 cache,
800-MHz front side bus (FSB)

√

●

T5270 1.40-GHz processor, 2-MB L2 cache,
800-MHz FSB

√

Intel Celeron® M processors
●

P550 2.0-GHz processor, 1-MB L2 cache, 533MHz FSB

√

●

P530 1.73-GHz processor, 1-MB L2 cache,
533-MHz FSB

√

Intel Celeron M processors, Dual Core
●
Chipset

T1400 1.73-GHz processor, 533Mhz FSB

√

Northbridge: Intel GME965 with up to 800-MHz FSB

√

Northbridge: Intel GLE960 with up to 533-MHz FSB

√

Southbridge: Intel ICH8M

√

√

Graphics

Intel Universal Memory Architecture (UMA)
graphics subsystem integrated with shared video
memory (dynamically allocated)

√

√

Panel

All display assemblies include 2 wireless local area
network (WLAN) antennae

√

√

●

√

√

2 customer-accessible/upgradable memory module
slots

√

√

Supports dual-channel memory

√

√

Supports up to 4 GB of system RAM

√

√

PC2-5300, 667-MHz, DDR2

√

√

Memory

15.4-inch WXGA BrightView
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Category

Description

Computer models
equipped with
GLE960 system
board

Computer models
equipped with
GME965 system
board

Supports the following configurations in all countries
and regions except Brazil:

√

√

√

√

Supports 9.5-mm, 2.5-inch hard drives

√

√

Customer-accessible

√

√

Serial ATA

√

√

Supports the following drives:

√

√

HP DriveGuard

√

√

Fixed (removal of 1 screw required)

√

√

Customer-accessible

√

√

12.7-mm tray load

√

√

Supports the “no optical drive” option

√

√

●

4096-MB total system memory (2048 × 2, dualchannel)

●

3072-MB total system memory (2048 + 1024)

●

2560-MB total system memory (2048 + 512)

●

2048-MB total system memory (1024 × 2, dualchannel)

●

2048-MB total system memory (2048 × 1)

●

1536-MB total system memory (1024 + 512)

●

1024-MB total system memory (512 × 2, dualchannel)

●

1024-MB total system memory (1024 × 1)

●

512-MB total system memory (512 × 1)

Supports the following configurations only in Brazil:

Hard drives

Optical drives
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●

2048-MB total system memory (2048 × 1)

●

2048-MB total system memory (1024 × 2, dualchannel)

●

1024-MB total system memory (1024 × 1)

●

1024-MB total system memory (512 × 2, dualchannel)

●

512-MB total system memory (512 × 1)

●

250-GB, 5400-rpm

●

160-GB, 5400-rpm

●

120-GB, 5400-rpm
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Category

Description

Computer models
equipped with
GLE960 system
board

Computer models
equipped with
GME965 system
board

Supports the following Parallel ATA (PATA) drives:

√

√

√

√

Supports external USB diskette drive only

√

√

Supports boot from external USB diskette drive

√

√

Supports 3-mode diskette drive

√

√

Audio

HD audio - ADI1981

√

√

Modem

56K V.92 1.5-inch data/fax modem with digital line
guard

√

√

Ethernet

Intel 82562GT

√

√

S3/S4/S5 wake on LAN: DC - no

√

√

S3/S4/S5 wake on LAN: AC - yes

√

√

●

DVD±RW and CD-RW SuperMulti DoubleLayer Combo Drive with LightScribe

●

DVD/CD-RW Combo Drive

●

DVD-ROM Drive

Supports the following Serial ATA (SATA) drives:

Diskette drive

Wireless

●

DVD±RW and CD-RW Supermulti DoubleLayer Combo Drive with LightScribe

●

DVD/CD-RW Combo Drive

●

DVD-ROM Drive

Integrated WLAN options by way of wireless module:
2 WLAN antennae built into display assembly

√

√

Support for no-WLAN option

√

√

Support for the following WLAN formats:

√

√

●

Broadcom 802.11a/b/g/n

●

Broadcom 802.11b/g

●

Intel 802.11a/b/g

●

Intel 802.11b/g

●

Intel 802.11a/b/g/n Kedron without iAMT

●

Intel 802.11a/b/g Kedron without iAMT

Integrated personal area network (PAN) options by way of Bluetooth® module:

External media card

Support for no-WPAN option

√

√

Broadcom Bluetooth 2.0+EDR

√

√

One ExpressCard/54 slot

√

√
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Category

Description

Computer models
equipped with
GLE960 system
board

Computer models
equipped with
GME965 system
board

SD Card Reader supporting Secure Digital (SD)
Memory Card and MultiMediaCard (MMC)

√

√

Audio-in (stereo microphone)

√

√

Audio-out (stereo headphone)

√

√

RJ-11 (modem)

√

√

RJ-45 (Ethernet, includes link and activity lights)

√

√

USB (3)

√

√

VGA (Dsub 15-pin) supporting 1600 × 1200 external
resolution at 75-GHz (hot plug/unplug with autodetect)

√

√

2-pin AC power

√

√

11.97-inch keyboard with embedded numeric
keypad

√

√

TouchPad only, with 2 TouchPad buttons and
vertical scrolling (taps enabled as default)

√

√

65-W AC adapter with localized cable plug support
(2-wire plug with ground pin, supports 2-pin DC
connector)

√

√

6-cell, 47-Wh Li-ion battery

√

√

Security

Supports Kensington security lock

√

√

Operating system

Preinstalled:
Windows Vista® Basic 32 with Office Ready

√

√

Windows Vista® Basic 32 Japan (in Japan only)

√

√

Windows Vista Basic 32 Japan with Office Personal
(in Japan only)

√

√

Windows Vista Basic 32 Japan with Office Personal
with PowerPoint (in Japan only)

√

√

Windows Vista Business 32 with Office Ready

√

√

Windows Vista Business 32 Japan (in Japan only)

√

Windows Vista Business 32 Japan with Office
Personal (in Japan only)

√

√

Windows Vista Business 32 Japan with Office
Personal with PowerPoint (in Japan only)

√

√

Windows Vista Business 32 Japan with Office
Professional (in Japan only)

√

√

Windows Vista Business with XP Professional with
Office Ready

√

√

Ports

Keyboard/pointing
devices

Power requirements

Windows Vista Basic 32 Japan with Office
Professional (in Japan only)
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Category

Description

Computer models
equipped with
GLE960 system
board

Computer models
equipped with
GME965 system
board

Windows Vista Business with XP Professional
Japan (in Japan only)

√

Windows Vista Business with XP Professional
Japan with Office Personal (in Japan only)

√

√

Windows Vista Business with XP Professional
Japan with Office Personal with PowerPoint (in
Japan only)

√

√

Windows Vista Business with XP Professional
Japan with Office Professional (in Japan only)

√

√

Windows Vista Home Premium with Office Ready

√

√

FreeDOS

√

√

Red Flag Linux (in the People's Republic of China
only)

√

√

Mandriva Linux

√

√

Windows Vista Basic 32

√

√

Windows Vista Home Premium

√

√

Windows Vista Business 32

√

√

Red Flag Linux (in the People's Republic of China
only)

√

√

DRDVD Windows Vista

√

√

DRDVD Windows XP Pro

√

√

Windows® XP Professional

√

√

Web Support: Windows® XP Professional

√

√

Certified: Microsoft® WHQL

√

√

AC adapter

√

√

Battery (system)

√

√

Hard drive

√

√

Memory module

√

√

Optical drive

√

√

WLAN module

√

√

Restore media:

Serviceability

End-user replaceable parts:
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External component identification

Top components
TouchPad

Item

Component

Function

(1)

TouchPad*

Moves the pointer and selects or activates items on the
screen.

(2)

Left TouchPad button*

Functions like the left button on an external mouse.

(3)

Right TouchPad button*

Functions like the right button on an external mouse.

(4)

TouchPad scroll zone

Scrolls up or down.

*This table describes factory settings. View or change pointing device preferences as follows:
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●

In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

●

In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.

Chapter 2 External component identification

Buttons, lights, and speaker

Item

Component

Function

(1)

Caps lock light

On: Caps lock is on.

(2)

Wireless button

Turns the wireless feature on or off but does not establish
a wireless connection.
NOTE: You must set up or access a wireless network to
establish a wireless connection.

(3)

(4)

Wireless light

Power button

●

Blue: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Broadband Wireless Module, and/or a Bluetooth
device, is on.

●

Amber: All wireless devices are off.

●

When the computer is off, press the button to turn on
the computer.

●

When the computer is on, press the button to initiate
Hibernation.

●

When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), press the button
briefly to exit the Sleep state or Standby.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the computer.
To learn more about power settings, follow these steps:
●

In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

●

In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options

Top components
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Item

Component

Function

(5)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state (Windows
Vista) or Standby (Windows XP).

●

Off: The computer is off or in Hibernation.

(6)

Speaker

Produces sound.

Item

Component

Function

(1)

esc key

Displays system information when pressed in combination
with the fn key.

(2)

fn key

Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3)

Windows logo key

Displays the Windows Start menu.

(4)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(5)

Embedded numeric keypad keys

Can be used like the keys on an external numeric keypad.

(6)

Function keys

Execute frequently used system functions when pressed
in combination with the fn key.

Keys
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Front components

Item

Component

Function

(1)

Audio-out (headphone) jack

Connects optional powered stereo speakers, headphones,
ear buds, a headset, or television audio.

(2)

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(3)

SD Card Reader

Supports the following optional digital card formats:
●

Secure Digital (SD) Memory Card

●

MultiMediaCard (MMC)

Front components
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Right-side components

Item

Component

Function

(1)

Optical drive

Reads an optical disc.

(2)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left-side components

Item

Component

Function

(1)

RJ-11 (modem) jack

Connects a modem cable.

(2)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3)

External monitor port

Connects an external VGA monitor or projector.

(4)

Power connector

Connects an AC adapter.

(5)

RJ-45 (network) jack

Connects a network cable.

(6)

USB ports (3)

Connect optional USB devices.

(7)

ExpressCard slot

Supports optional ExpressCards.

(8)

Battery light

●

Amber: A battery is charging.

●

Turquoise: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

Left-side components
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Bottom components

Item

Component

Function

(1)

Battery release latches (2)

Release the battery from the battery bay.

(2)

Battery bay

Holds the battery.

(3)

Vents (6)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4)

Memory module compartment

Contains the memory module slots.

(5)

WLAN module compartment (select models only)

Contains a WLAN module slot.
NOTE: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for
use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

(6)
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Hard drive bay

Chapter 2 External component identification

Holds the hard drive.

Wireless antennae (select models only)
On select computer models, at least 2 antennae send and receive signals from one or more wireless
devices. These antennae are not visible from the outside of the computer.

NOTE: For optimal transmission, keep the areas immediately around the antennae free from
obstructions.
To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.

Wireless antennae (select models only)
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Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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●

Product Name (1). This is the product name affixed to the front of the computer.

●

Serial Number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

●

Part Number/Product Number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

●

Model Description (4). This is the number you use to locate documents, drivers, and support for
your notebook.

●

Warranty Period (5). This number describes the duration (in years) of the warranty period for this
computer.

Chapter 3 Illustrated parts catalog

Computer major components

Computer major components
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Item

Description

(1)

Display assemblies (include 2 WLAN antenna transceivers and cables)
15.4-inch, WXGA BrightView

Spare part number

495385-001

Display assembly internal components:
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Display enclosure (includes 2 WLAN antenna transceivers and cables)

495402-001

Display hinges (includes left and right hinges)

456806-001

Display inverter

456618-001

Display Cable Kit (includes 2 wireless antennae)

508816-001

(2)

Switch cover (includes button board and cable)

495388-001

(3)

Keyboards
For use in Belgium

495400-181

For use in Brazil

495400-201

For use in the Czech Republic

495400-221

For use in Denmark

495400-081

For use in France

495400-051

For use in French Canada

495400-121

For use in Germany

495400-041

For use in Greece

495400-DJ1

For use in Hungary

495400-211

For use in Iceland

495400-DD1

For use in Israel

495400-BB1

For use in Italy

495400-061

For use in Japan

495400-291

For use in Latin America

495400-161

For use in the Netherlands

495400-B31

For use in Norway

495400-091

For use in Portugal

495400-131

For use in Russia

495400-251

For use in Saudi Arabia

495400-171

For use in Slovakia

495400-231

For use in Slovenia

495400-BA1

For use in South Korea

495400-AD1

For use in Spain

495400-071

For use in Sweden

495400-B71

For use in Switzerland

495400-BG1

Chapter 3 Illustrated parts catalog

Item

Description

Spare part number

For use in Taiwan

495400-AB1

For use in Thailand

495400-281

For use in Turkey

495400-141

For use in the United Kingdom

495400-031

For use in the United States

495400-001

(4)

Speaker

456593-001

(5)

Top cover (includes TouchPad board and cable, and TouchPad button board and cable)

495399-001

Plastics Kit (see Plastics Kit on page 21 for more Plastics Kit spare part information):

456614-001

(6a)

ExpressCard slot protective insert

(6b)

WLAN module compartment cover

(6c)

Memory module compartment cover

(6d)

Hard drive bay cover

(6e)

Optical drive bay protective insert (not illustrated)
TouchPad components (included with the top cover)

(7a)

TouchPad bracket

(7b)

TouchPad board (includes cable)

(7c)

Touchpad button board (includes cable)

(8)

ExpressCard assembly (included with all system boards)

(9)

System boards (include replacement thermal material and the ExpressCard assembly)
For use only with computer models equipped with Intel GME965 graphics chipset, Intel UMA
graphics subsystem, and PATA optical drive

495410-001

For use only with computer models equipped with Intel GLE960 graphics chipset, Intel UMA
graphics subsystem, and PATA optical drive

495395-001

For use only with computer models equipped with Intel GME965 graphics chipset, Intel UMA
graphics subsystem, and SATA optical drive

495404-001

For use only with computer models equipped with Intel GLE960 graphics chipset, Intel UMA
graphics subsystem, and SATA optical drive

495397-001

(10)

Fan

431312-001

(11)

Optical drive connector board

(12)

Optical drive connector board (PATA)

456805-001

Optical drive connector board (SATA)

495386-001

Broadcom Bluetooth modules (do not include Bluetooth module cable)
NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module cable
is included in the Cable Kit, spare part number 456594-001. See Cable Kit on page 22 for more Cable Kit spare
part number information.
For use in all countries and regions except Japan and Asia Pacific countries and regions

398393-002

For use only in Japan and Asia Pacific countries and regions

450066-001

Computer major components
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Item

Description

Spare part number

(13)

Heat sink (includes replacement thermal material)

456605-001

(14)

Processors (includes replacement thermal material)
Intel Core2 Duo processors:
●

T5670 1.80-GHz (2-MB L2 cache, 800-MHz FSB)

508758-001

●

T5470 1.60-GHz (2-MB L2 cache, 800-MHz FSB)

500757-001

●

T5270 1.40-GHz (2-MB L2 cache, 800-MHz FSB)

495383-001

Intel Celeron M processors:
●

P550 2.0-GHz (1-MB L2 cache, 533-MHz FSB)

508759-001

●

P530 1.73-GHz (1-MB L2 cache, 533-MHz FSB)

500756-001

Intel Celeron M Dual processors:
●

T1400 1.73-GHz (1–MB L2 cache, 533-MHz FSB)

(15)

RTC battery

(16)

Modem module

506446-001
449137-001

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 456954-001. See Cable
Kit on page 22 for more Cable Kit spare part number information.

(17)

(18)

For use in the United States

461749-001

For use in Australia and New Zealand

461749-011

Base enclosure (includes rubber feet)

495398-001

Rubber Kit (not illustrated, contains 4 computer feet and 8 display bezel screw covers)

500132-001

Battery
6-cell, 47-Wh Li-ion battery

(19)

500764-001

WLAN modules
Intel 802.11a/b/g/n WLAN modules:
●

For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

441086-001

●

For use in Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441086-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

●

For use in South Korea

441086-AD1

Broadcom 802.11a/b/g/n Sangria M/C WLAN modules:
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Item

Description

Spare part number

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia,
Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States,
Uruguay, Venezuela, and Vietnam

487330-001

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri
Lanka, Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

487330-002

Intel 802.11a/b/g WLAN modules:
●

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the
United States, Uruguay, Venezuela, and Vietnam

441082-001 and
451861-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441082-002 and
451861-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441082-003 and
451861-003

●

For use in Japan

441082-292 and
451861-291

Intel 802.11b/g WLAN module for use in Thailand

451861-004

Broadcom 802.11b/g WLAN modules:
●

For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands,
and the United States

459263-001

Computer major components
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Item

(20)

(21)

(22)

Description

Spare part number

●

459263-002

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia & Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, the Central African
Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New
Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent &
Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Memory modules (PC2-5300, 667-MHz, DDR2)
2-GB

500759-001

1-GB

500758-001

512-MB

500760-001

Hard drives (include hard drive bracket)
250-GB, 5400-rpm

500763-001

160-GB, 5400-rpm

500762-001

120-GB, 5400-rpm

500761-001

Optical drives (include bezel and bracket)
Supports the following PATA optical drives:
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

500768-001

DVD/CD-RW Combo Drive

500767-001

DVD-ROM Drive

500766-001

Supports the following SATA optical drives:
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DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

507116-001

DVD/CD-RW Combo Drive

507117-001

DVD-ROM Drive

507115-001

Cable Kit (not illustrated; see Cable Kit on page 22 for more Cable Kit spare part number
information)

456594-001
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Plastics Kit

Item

Description

Spare part number

Plastics Kit:

456614-001

(1)

Hard drive bay cover (includes 2 captive screws, secured by C-clips)

(2)

WLAN module compartment cover (includes one captive screw, secured by a C-clip)

(3)

ExpressCard slot protective insert

(4)

Memory module compartment cover (includes one captive screw, secured by a C-clip)

(5)

Optical drive bay protective insert (not illustrated)

Plastics Kit
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Cable Kit

Item
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Description

Spare part number

Cable Kit:

456594-001

(1)

RJ-11 jack cable

(2)

Display lid switch module and cable

(3)

Bluetooth module cable
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Mass storage devices

Item

Description

(1)

Optical drives (include bezel and bracket)

Spare part number

Supports the following PATA optical drives:
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

500768-001

DVD/CD-RW Combo Drive

500767-001

DVD-ROM Drive

500766-001

Supports the following SATA optical drives:

(2)

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

507116-001

DVD/CD-RW Combo Drive

507117-001

DVD-ROM Drive

507115-001

Hard drives (include bracket)
250-GB, 5400-rpm

500763-001

160-GB, 5400-rpm

500762-001

120-GB, 5400-rpm

500761-001

Mass storage devices
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Miscellaneous parts
Description

Spare part number

65-W AC adapter

417220-001

Logo Kit

495408-001

Nylon carrying case

325814-001

USB 1.1 diskette drive

359118-001

Power cords:
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For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-201

For use in Denmark

490371-081

For use in Europe, the Middle East, and Africa

490371-021

For use in India

490371-D61

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

For use in Taiwan

490371-AB1

For use in the United Kingdom

490371-031
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Description

Spare part number

For use the United States

490371-001

Screw Kit

500131-001

●

Phillips PM3.0×4.0 screw

●

Phillips PM2.5×12.0 captive screw

●

Phillips PM2.5×10.0 captive screw

●

Phillips PM2.5×7.0 captive screw

●

Phillips PM2.5×7.0 screw

●

Phillips PM2.5×4.0 screw

●

Phillips PM2.0×8.0 screw

●

Phillips PM2.0×6.0 screw

●

Phillips PM2.0×5.0 captive screw

●

Phillips PM2.0×4.0 screw

●

Phillips PM2.0×2.0 broadhead screw

●

Torx T8M2.5×9.0 screw

●

Slotted Torx ST8M2.5×7.0 screw

●

Torx T8M2.5×6.0 screw

●

Torx T8M2.5×4.0 screw

●

Torx T8M2.5×3.0 broadhead screw

●

Torx T8M2.0×4.0 screw

Sequential part number listing
Spare part
number

Description

398393-002

Bluetooth module for use in North America
NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cable Kit, spare part number 456594-001. See Cable Kit on page 22 for more Cable
Kit spare part number information.

417220-001

65-W AC adapter

431312-001

Fan

441082-001

Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

Sequential part number listing
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Spare part
number

Description

441082-002

Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441082-003

Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea

441082-292

Intel 802.11a/b/g WLAN module for use in Japan

441086-001

Intel 802.11a/b/g/n WLAN module for use in the United States

441086-002

Intel 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441086-003

Intel 802.11a/b/g/n WLAN module for use in Australia, New Zealand, Pakistan, and the People's Republic of
China

441086-AD1

Intel 802.11a/b/g/n WLAN module for use in South Korea

449137-001

RTC battery

450066-001

Bluetooth module for use in Japan and Asia Pacific countries and regions
NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth module
cable is included in the Cable Kit, spare part number 456594-001. See Cable Kit on page 22 for more Cable
Kit spare part number information.
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451861-001

Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

451861-002

Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

4451861-003

Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea

451861-004

Intel 802.11b/g WLAN module for use in Thailand

451861-291

Intel 802.11a/b/g WLAN module for use in Japan

456593-001

Speaker

456594-001

Cable Kit (see Cable Kit on page 22 for more Cable Kit spare part information)

456605-001

Heat sink (includes replacement thermal material)

456614-001

Plastics Kit (see Plastics Kit on page 21 for more Plastics Kit spare part information)

456618-001

Display inverter

456805-001

Optical drive connector board (PATA)
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Spare part
number

Description

456806-001

Display hinges (includes left and right hinges)

459263-001

Broadcom 802.11b/g WLAN module for use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin
Islands, and the United States

459263-002

Broadcom 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

461749-001

Modem module (includes modem module cable)
NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 456594-001. See Cable Kit on page 22 for more Cable
Kit spare part number information.

461749-011

Modem module (includes modem module cable) for use in Australia and New Zealand
NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 456594-001.

487330-001

Broadcom 802.11a/b/g/n WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas,
Barbados, Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

487330-002

Broadcom 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria,
Croatia, Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco,
the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

490371-001

Power cord for use in the United States

490371-011

Power cord for use in Australia and New Zealand

490371-021

Power cord for use in Europe, the Middle East, Africa

490371-031

Power cord for use in the United Kingdom

490371-061

Power cord for use in Italy

490371-081

Power cord for use in Denmark

490371-111

Power cord for use in Switzerland

Sequential part number listing
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Spare part
number

Description

490371-201

Power cord for use in Brazil

490371-291

Power cord for use in Japan

490371-AA1

Power cord for use in the People's Republic of China

490371-AB1

Power cord for use in Taiwan

490371-AD1

Power cord for use in South Korea

490371-AR1

Power cord for use in Africa

490371-BB1

Power cord for use in Israel

490371-D01

Power cord for use in Argentina

490371-D61

Power cord for use in India

495383-001

Intel Core2 Duo T5270 1.40-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

495385-001

15.4-inch, WXGA display assembly (includes 2 WLAN antenna transceivers and cables)

495386-001

Optical drive connector board (SATA)

495388-001

Switch cover (includes button board and cable)

495395-001

System board for use only with computer models equipped with Intel GLE960 graphics chipset, Intel UMA
graphics subsystem, and PATA optical drive (includes replacement thermal material and the ExpressCard
assembly)

495397-001

System board for use only with computer models equipped with Intel GLE960 graphics chipset, Intel UMA
graphics subsystem, and SATA optical drive (includes replacement thermal material and the ExpressCard
assembly)

495398-001

Base enclosure (includes rubber feet)

495399-001

Top cover (includes TouchPad board and cable, and TouchPad button board and cable)

495400-001

Keyboard for use in the United States

495400-031

Keyboard for use in the United Kingdom

495400-041

Keyboard for use in Germany

495400-051

Keyboard for use in France

495400-061

Keyboard for use in Italy

495400-071

Keyboard for use in Spain

495400-081

Keyboard for use in Denmark

495400-091

Keyboard for use in Norway

495400-121

Keyboard for use in French Canada

495400-131

Keyboard for use in Portugal

495400-141

Keyboard for use in Turkey

495400-161

Keyboard for use in Latin America

495400-171

Keyboard for use in Saudi Arabia

495400-181

Keyboard for use in Belgium
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Spare part
number

Description

495400-201

Keyboard for use in Brazil

495400-211

Keyboard for use in Hungary

495400-221

Keyboard for use in the Czech Republic

495400-231

Keyboard for use in Slovakia

495400-251

Keyboard for use in Russia

495400-281

Keyboard for use in Thailand

495400-291

Keyboard for use in Japan

495400-AB1

Keyboard for use in Taiwan

495400-AD1

Keyboard for use in South Korea

495400-B31

Keyboard for use in the Netherlands

495400-B71

Keyboard for use in Sweden and Finland

495400-BA1

Keyboard for use in Slovenia

495400-BB1

Keyboard for use in Israel

495400-BG1

Keyboard for use in Switzerland

495400-DD1

Keyboard for use in Iceland

495400-DJ1

Keyboard for use in Greece

495402-001

Display enclosure (includes 2 WLAN antenna transceivers and cables)

495404-001

System board for use only with computer models equipped with Intel GME965 graphics chipset, Intel UMA
graphics subsystem, and SATA optical drive (includes replacement thermal material and the ExpressCard
assembly)

495408-001

Logo Kit

495410-001

System board for use only with computer models equipped with Intel GME965 graphics chipset, Intel UMA
graphics subsystem, and PATA optical drive (includes replacement thermal material and the ExpressCard
assembly)

500131-001

Screw Kit

500132-001

Rubber Kit (contains 4 computer feet and 8 display bezel screw covers)

500756-001

Intel Celeron M P530 1.73-GHz processor (1-MB L2 cache, 533-MHz FSB, includes replacement thermal
material)

500757-001

Intel Core2 Duo T5470 1.40-GHz processor (2-MB L2 cache, 800-MHz FSB, includes replacement thermal
material)

500758-001

1-GB memory module (PC2-5300, 667-MHz, DDR2)

500759-001

2-GB memory module (PC2-5300, 667-MHz, DDR2)

500760-001

512-MB memory module (PC2-5300, 667-MHz, DDR2)

500761-001

120-GB, 5400-rpm hard drive (includes bracket)

500762-001

160-GB, 5400-rpm hard drive (includes bracket)

500763-001

250-GB, 5400-rpm hard drive (includes bracket)

Sequential part number listing
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Spare part
number

Description

500764-001

6-cell, 47-Wh Li-ion battery

500766-001

DVD-ROM Drive (includes bezel and bracket) (PATA)

500767-001

DVD/CD-RW Combo Drive (includes bezel and bracket) (PATA)

500768-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe (includes bezel and bracket)
(PATA)

506446-xx1

T1400 1.73-GHz processor (1-MB L2 cache, 533-MHz FSB)

507115-001

DVD-ROM Drive (includes bezel and bracket) (SATA)

507116-001

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe (includes bezel and bracket)
(SATA)

507117-001

DVD/CD-RW Combo Drive (includes bezel and bracket) (SATA)

508758-001

T5670 1.80-GHz processor (2-MB L2 cache, 800-MHz FSB)

508759-001

P550 2.0-GHz processor (1-MB L2 cache, 533-MHz FSB)

508816-001

Display Cable Kit (contains 2 wireless antennae)
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Magnetic screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Preliminary replacement requirements
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION:

A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity

Event

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
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●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:
NOTE:

These steps also clear CMOS.

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the real-time clock (RTC) battery (see RTC battery on page 78).

6.

Wait approximately 5 minutes.

7.

Replace the RTC battery and reassemble the computer.

8.

Connect AC power to the computer. Do not reinsert any batteries at this time.

9.

Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 82 screws, in 18 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.

●

Product Name (1). This is the product name affixed to the front of the computer.

●

Serial Number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

●

Part Number/Product Number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

●

Model Description (4). This is the number you use to locate documents, drivers, and support for
your notebook.

●

Warranty Period (5). This number describes the duration (in years) of the warranty period for this
computer.

Component replacement procedures
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Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 500132-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery
Description

Spare part number

6-cell, 47-Wh Li-ion battery

500764-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside down on a flat surface, with the battery bay toward you.

2.

Slide the battery release latches (1) to release the battery.

3.

Remove the battery (2) from the computer.

Insert the battery into the battery bay until it is seated. The battery release latches automatically lock
the battery into place.

Component replacement procedures
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Hard drive
NOTE:

All hard drive spare part kits include a hard drive bracket.

Description

Spare part number

250-GB, 5400-rpm hard drive

500763-001

160-GB, 5400-rpm hard drive

500762-001

120-GB, 5400-rpm hard drive

500761-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

Remove the hard drive:
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1.

Position the computer with the front toward you.

2.

Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the hard drive bay cover to the
computer.

3.

Lift the right side of the hard drive bay cover (2), swing it to left, and remove the cover. The hard
drive bay cover is included in the Plastics Kit, spare part number 456614-001.

4.

Loosen the Phillips PM2.5×12.0 captive screw (1) that secures the hard drive to the computer.

5.

Grasp the Mylar tab (2) on the hard drive and slide the hard drive (3) to the left to disconnect it from
the system board.
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6.

Remove the hard drive (4) from the hard drive bay.

7.

If it is necessary to replace the hard drive bracket, remove the two Phillips PM3.0×4.0 hard drive
bracket screws (1) from each side of the hard drive.

8.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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WLAN module
Description

Spare part number

Intel 802.11a/b/g/n WLAN modules:
●

For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441086-003

●

For use in Japan

441086-291

Broadcom 802.11a/b/g/n Sangria M/C WLAN modules:
For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador, El
Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and
Vietnam

487330-001

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary, Iceland,
Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland,
Turkey, Ukraine, the United Kingdom, and Uzbekistan

487330-002

Intel 802.11a/b/g WLAN modules:
●

For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam

441082-001 and
451861-001

●

For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-002 and
451861-002

●

For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea

441082-003 and
451861-003

●

For use in Japan

441082-292 and
451861-291

Broadcom 802.11b/g WLAN modules:
●
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For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States
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459263-001

Description

Spare part number

●

459263-002
For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic
of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

●

For use in Japan

459263-291

Intel 802.11b/g WLAN module for use in Thailand

451861-004

Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

Remove the WLAN module:
1.

Position the computer with the front toward you.

2.

Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the WLAN module compartment
cover to the computer.
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3.

Lift the right side of the WLAN module compartment cover (2), swing it to left, and remove the
cover. The WLAN module compartment cover is included in the Plastics Kit, spare part number
456614-001.

4.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

5.

Remove the two Phillips PM2.5×4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

6.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Memory module
Description

Spare part number

2-GB (PC2-5300, 667-MHz, DDR2)

500759-001

1-GB (PC2-5300, 667-MHz, DDR2)

500758-001

512-MB (PC2-5300, 667-MHz, DDR2)

500760-001

Before removing the memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

Remove the memory module:
1.

Loosen the Phillips PM2.0×5.0 captive screw (1) that secures the memory module compartment
cover to the computer.

2.

Lift the front edge of the cover (2), swing it up and back, and remove the cover. The memory module
compartment cover is included in the Plastics Kit, spare part number 456614-001.

3.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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4.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.

Optical drive
NOTE:

All optical drive spare part kits include an optical drive bezel.

Description

Spare part number

Supports the following PATA optical drives:
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

500768-001

DVD/CD-RW Combo Drive

500767-001

DVD-ROM Drive

500766-001

Optical drive connector board (PATA)

456805-001

Supports the following SATA optical drives:
DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

507116-001

DVD/CD-RW Combo Drive

507117-001

DVD-ROM Drive

507115-001

Optical drive connector board (SATA)

495386-001

Before removing the optical drive, follow these steps:

46

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

Remove the optical drive:
1.

Position the computer with the right side toward you.

2.

Remove the slotted Torx ST8M2.5×7.0 screw (1) that secures the optical drive to the computer.

3.

Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4.

Remove the optical drive (3) from the computer.

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6.

Remove the two Phillips PM2.0×4.0 screws (1) that secure the optical drive bracket to the optical
drive.

7.

Remove the optical drive bracket (2).
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Reverse this procedure to reassemble and install an optical drive.

Switch cover
Description

Spare part number

Switch cover (includes button board and cable)

495388-001

Before removing the switch cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

Remove the switch cover:
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1.

Turn the computer upside down, with the rear panel toward you.

2.

Remove the two slotted Torx T8M2.5×9.0 screws (1) and the three Torx T8M2.5×3.0 broadhead
screws (2) that secure the switch cover to the computer.

3.

Turn the computer right-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Release the ZIF connector to which the button board cable (1) is attached, and disconnect the
cable from the system board.
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6.

Remove the switch cover (2) by lifting it straight up.

Reverse this procedure to install the switch cover.
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Keyboard
For use in:

Spare part number

For use in:

Spare part number

Belgium

495400-181

Norway

495400-091

Brazil

495400-201

Portugal

495400-131

The Czech Republic

495400-221

Russia

495400-251

Denmark

495400-081

Saudi Arabia

495400-171

France

495400-051

Slovakia

495400-231

French Canada

495400-121

Slovenia

495400-BA1

Germany

495400-041

South Korea

495400-AD1

Greece

495400-DJ1

Spain

495400-071

Hungary

495400-211

Sweden and Finland

495400-B71

Iceland

495400-DD1

Switzerland

495400-BG1

Israel

495400-BB1

Taiwan

495400-AB1

Italy

495400-061

Thailand

495400-281

Japan

495400-291

Turkey

495400-141

Latin America

495400-161

The United Kingdom

495400-031

The Netherlands and Europe

495400-B31

The United States

495400-001

Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the switch cover (see Switch cover on page 48).

Remove the keyboard:
1.
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Position the computer with the front toward you.
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2.

Remove the two slotted Torx ST8M2.5×7.0 screws that secure the keyboard to the computer.

3.

Turn the computer display-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Lift the rear edge of the keyboard (1) and slide it back until it rests on the display assembly (2).
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6.

Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

7.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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Speaker
Description

Spare part number

Speaker

456593-001

Before removing the speaker, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the keyboard (see Keyboard on page 50).

6.

Remove the switch cover (see Switch cover on page 48).

Remove the speaker:
1.

Disconnect the speaker cable (1) from the system board.

2.

Remove the two Torx T8M2.5×4.0 screws (2) that secure the speaker to the top cover.

3.

Remove the speaker (3) from the top cover.

Reverse this procedure to install the speaker.
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Display lid switch module
NOTE: The display lid switch module is included in the Cable Kit, spare part number Cable Kit, spare
part number 456594-001.
Before removing the display lid switch module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the keyboard (see Keyboard on page 50).

6.

Remove the switch cover (see Switch cover on page 48).

Remove the display lid switch module:
1.

Disconnect the display lid switch module cable (1) from the system board.

2.

Remove the display lid switch module (2) from the clip built into the top cover.

3.

Remove the display lid switch module cable from the clips (3) built into the top cover.

Reverse this procedure to install the display lid switch module.
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Display assembly
NOTE:

All display assembly spare part kits include 2 WLAN antenna transceivers and cables.

Description

Spare part number

15.4-inch, WXGA with BrightView

495385-001

Display Cable Kit (includes 2 wireless antennae)

508816-001

Before removing the display assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 42).

6.

Remove the following components:
a.

Keyboard (see Switch cover on page 48

b.

Switch cover (see Switch cover on page 48)

c.

Speaker (see Speaker on page 53)

d.

Display lid switch module (see Display lid switch module on page 54)

Remove the display assembly:
1.

Close the computer and turn it upside down, with the rear panel toward you.

2.

Remove the two slotted Torx ST8M2.5×7.0 screws that secure the display assembly to the
computer.
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3.

Turn the computer right-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Disconnect the display panel cables (1) and (2) from the system board.

6.

Remove the wireless antenna cables (3) from the clips and routing channels built into the top cover.

7.

Remove the four slotted Torx ST8M2.5×7.0 screws (1) that secure the display assembly to the
computer.
CAUTION: Support the display assembly when removing the following screws. Failure to support
the display assembly can result in damage to the display assembly and other computer
components.

8.
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Lift the display assembly (2) straight up and remove it.
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9.

If it is necessary to replace the display bezel, display inverter, or display hinges, remove the eight
rubber screw covers (1) and the eight Torx T8M2.5×6.0 screws (2) that secure the display bezel
to the display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
500132-001.

10. Flex the inside edges of the left and right sides (1) and the top and bottom sides (2) of the display
bezel until the bezel disengages from the display enclosure.
11. Remove the display bezel (3). The display bezel is available using spare part number
495402-001.

12. If it is necessary to replace the display inverter, remove the inverter (1) from the display enclosure
as far as the display panel cable and the backlight cable will allow.
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13. Disconnect the display panel cable (2) and the backlight cable (3) from the display inverter.

14. Remove the display inverter. The display inverter is available using spare part number
456618-001.
15. If it is necessary to replace the display hinges, remove the four Torx T8M2.5×6.0 screws (1) that
secure the display panel to the display enclosure.
16. Remove the display panel (2).

17. Remove the four Phillips PM2.0×4.0 screws (1) that secure each display hinge to the display
panel.
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18. Remove the display hinges (2). The left and right display hinges are available using spare part
number 456806-001.

Reverse this procedure to reassemble and install the display assembly.
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Top cover
NOTE:
cable.

The top cover includes the TouchPad board and cable, and the TouchPad button board and

Description

Spare part number

Top cover

495399-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

Remove the top cover:
1.
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Turn the computer upside down, with the front toward you.
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2.

Remove the followng screws:
(1) Three Phillips PM2.0×2.0 broadhead screws
(2) Seven slotted Torx ST8M2.5×7.0 screws
(3) One Torx T8m2.5×4.0 screw

3.

Turn the computer right-side up, with the left side toward you.

4.

Press in on the ExpressCard slot eject button (1) two times. The first press releases the
ExpressCard slot eject button. The second press releases the ExpressCard slot protective insert,
if one is present, from the ExpressCard slot.

5.

Remove the ExpressCard slot insert(2).

6.

Remove the three slotted Torx ST8M2.5×7.0 screws (3) that secure the top cover to the computer.

7.

Lift the rear edge of the top cover (1) and swing it up and forward until it rests at an angle.

8.

Lift the front edge of the top cover (2) until it disengages from the base enclosure.

9.

Tilt the top cover (3) back until the TouchPad cable is accessible.
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10. Release the ZIF connector (4) to which the TouchPad cable is connected and disconnect the
TouchPad cable (5) from the system board.

11. Remove the top cover.
Reverse this procedure to install the top cover.

62

Chapter 4 Removal and replacement procedures

TouchPad board and TouchPad button board
NOTE: The top cover, spare part number 495399-001, includes the TouchPad board and cable, and
the TouchPad button board and cable.
Before removing the TouchPad board and TouchPad button board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

Remove the TouchPad board and TouchPad button board:
1.

Turn the top cover upside down, with the front toward you.

2.

Release the ZIF connectors on the TouchPad button board (1) and TouchPad board (2) to which
the TouchPad board cable is connected.

3.

Disconnect and remove the TouchPad board cable (3).
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4.

Remove the two Phillips PM2.0×4.0 screws (4) that secure the TouchPad bracket to the computer.

5.

Release the TouchPad bracket (1) by sliding it back.

6.

Remove the TouchPad bracket (2) by lifting it straight up.

7.

Remove the TouchPad button board (3).

8.

Remove the TouchPad button board cable (4) from the opening in the TouchPad bracket.
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9.

Remove the TouchPad board (1) from the top cover.
NOTE: When replacing the TouchPad board and TouchPad button board, be sure the TouchPad
button actuators (2) are installed in the top cover.

Reverse this procedure to install the TouchPad board and TouchPad button board.

Bluetooth module
NOTE: The Bluetooth module spare part kits do not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 456594-001.
Description

Spare part number

For use in all countries and regions except Japan and Asia Pacific countries and regions

398393-001

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)
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f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

Remove the Bluetooth module:
1.

Disconnect the Bluetooth module cable (1) from the system board.

2.

Remove the two Phillips PM2.0×4.0 screws (2) that secure the Bluetooth module to the base
enclosure.

3.

Remove the Bluetooth module (3) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

System board
NOTE:

All system board spare part kits include the ExpressCard assembly.

NOTE: All system board spare part kits include replacement thermal material. Replacement thermal
material is also available in the heat sink spare part kit, spare part number 456605-001.
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Description

Spare part number

For use only with computer models equipped with Intel GME965 graphics chipset, Intel UMA
graphics subsystem, and PATA optical drive

495410-001

For use only with computer models equipped with Intel GLE960 graphics chipset, Intel UMA graphics
subsystem, and PATA optical drive

495395-001

For use only with computer models equipped with Intel GME965 graphics chipset, Intel UMA
graphics subsystem, and SATA optical drive

495404-001

For use only with computer models equipped with Intel GLE960 graphics chipset, Intel UMA graphics
subsystem, and SATA optical drive

495397-001
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Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:
●

Memory module (see Memory module on page 45)

●

WLAN module (see WLAN module on page 42)

●

Processor (see Processor on page 74)

●

ExpressCard assembly (see ExpressCard assembly on page 79)

Remove the system board:
1.

Remove the RJ-11 jack (1) from the clip built into the base enclosure and remove the RJ-11 jack
cable from the hook (2) built into the base enclosure.
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2.

Disconnect the fan cable (3) and the Bluetooth module cable (4) from the system board.

3.

Remove the following screws:
(1) Two Phillips PM2.0×6.0 screws
(2) Two Torx T8M2.0×4.0 screws
(3) One Torx T8M2.5×4.0 screw
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4.

Flex the left side of the base enclosure (1) until the external monitor connector (2) is clear of the
opening in the base enclosure.

5.

Lift the rear edge of the system board (3) until it rests at an angle.
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6.

Remove the system board (4) from the base enclosure by sliding it back.

7.

If it is necessary to replace the optical drive connector board, remove it from the connector on the
system board. The optical drive connector board is available using spare part numbers 456805-001
(PATA) or 495386-001 (SATA).

Reverse the preceding procedure to install the system board.
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Fan
Description

Spare part number

Fan

431312-001

Before removing the fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

i.

System board (see System board on page 66)

Remove the fan:
1.
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Remove the two Phillips PM2.5×7.0 screw s(1) that secures the fan to the base enclosure.
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2.

Remove the fan (2) from the base enclosure.

Reverse this procedure to install the fan.
NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.
The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Heat sink
NOTE:

The heat sink spare part kit includes replacement thermal material.

Description

Spare part number

Heat sink (includes replacement thermal material)

456605-001

Before removing the heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

i.

System board (see System board on page 66)

Remove the heat sink:
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1.

Turn the system board upside down, with the USB connectors toward you.

2.

Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four Phillips PM2.5×10.0
screws (1) that secure the heat sink to the system board.
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3.

Remove the heat sink (2).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
(2), the processor (3), and graphics system component (4) each time the heat sink is removed. Thermal
pads and thermal paste must be installed on all surfaces before the heat sink assembly is reinstalled.
Thermal material is included with all heat sink and processor spare part kits.

Reverse this procedure to install the heat sink.
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Processor
NOTE: All processor spare part kits include replacement thermal material. Replacement thermal
material is also available in the heat sink spare part kit, spare part number 456605-001.
Description

Spare part number

Intel Core2 Duo processors:
●

T5670 1.80-GHz (2-MB L2 cache, 800-MHz FSB)

508758-001

●

T5470 1.60-GHz (2-MB L2 cache, 800-MHz FSB)

500757-001

●

T5270 1.40-GHz (2-MB L2 cache, 800-MHz FSB)

495383-001

Intel Celeron M processors:
●

P550 2.0-GHz (1-MB L2 cache, 533-MHz FSB)

508759-001

●

P530 1.73-GHz (1-MB L2 cache, 533-MHz FSB)

500756-001

Intel Celeron M Dual Core processors:
●

T1400 1.73-GHz (1–MB L2 cache, 533-MHz FSB)

506446-001

Before removing the processor, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

i.

System board (see System board on page 66)
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Remove the processor:
1.

Turn the system board upside down, with the USB connectors toward you.

2.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn counterclockwise
until you hear a click.

3.

Lift the processor (2) straight up and remove it.
NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 456594-001.
Description

Spare part number

For use in the United States

461749-001

For use in Australia and New Zealand

461749-011

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

i.

System board (see System board on page 66)

Remove the modem module:
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1.

Turn the system board upside down, with the USB connectors toward you.

2.

Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system board.
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3.

Lift the modem module (2) straight up to disconnect it from the system board.

4.

Remove the modem module.

Reverse this procedure to install the modem module.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.
Description

Spare part number

RTC battery

449137-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

i.

System board (see System board on page 66)

Remove the RTC battery:
1.
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Turn the system board upside down, with the audio connectors toward you.

Chapter 4 Removal and replacement procedures

2.

Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.

ExpressCard assembly
NOTE:

All system board spare part kits include the ExpressCard assembly.

Before removing the ExpressCard assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 39).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 40)

b.

Optical drive (see Optical drive on page 46)

c.

Keyboard (see Keyboard on page 50)

d.

Switch cover (see Switch cover on page 48)

e.

Speaker (see Speaker on page 53)

f.

Display lid switch module (see Display lid switch module on page 54)

g.

Display assembly (see Display assembly on page 55)

h.

Top cover (see Top cover on page 60)

i.

System board (see System board on page 66)
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Remove the ExpressCard assembly:
1.

Turn the system board upside down, with the USB connectors toward you.

2.

Remove the two Phillips PM2.0×8.0 screws (1) and the two Phillips PM2.0×4.0 screws (2) that
secure the ExpressCard assembly to the system board.

3.

Turn the system board right-side up, with the USB connectors toward you.

4.

Remove the ExpressCard assembly from the system board.

Reverse this procedure to install the ExpressCard assembly.
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Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.
NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer.

2.

Before Windows® opens and while the “F10=ROM Based Setup” message is displayed in the
lower-left corner of the screen, press f10.

Starting Computer Setup
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Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.
1.

Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.
Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation
and selection are by keystroke:
●

To choose a menu or a menu item, use the arrow keys.

●

To select an item, press enter.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc.

●

To view navigation information, press f1.

●

To change the language, press f2.

2.

Select the File, Security, Diagnostics, or System Configuration menu.

3.

To exit Computer Setup, choose one of the following methods:
●

To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

●

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2.

Use the arrow keys to select File > Restore defaults, and then press enter.

3.

When the confirmation dialog box opens, press f10.

4.

To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu
Select

To do this

System information

●

View identification information for the computer and the
batteries in the system.

●

View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Restore defaults

Replace the configuration settings in Computer Setup with the
original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore changes and exit

Cancel any changes entered during the current session. Then
exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect when
the computer restarts.

Computer Setup menus
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Security menu
Select

To do this

Setup password

Enter, change, or delete a setup password.

Power-On password

Enter, change, or delete a power-on password.

Password options

●

Enable/disable stringent security.

●

Enable/disable password requirement on computer
restart.

●

Enable/disable DriveLock on any computer hard drive
and on optional MultiBay hard drives.

●

Change a DriveLock user password or master password.

DriveLock passwords

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
System IDs

Enter user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:
●

Fast: Runs the Disk Sanitizer erase cycle once.

●

Optimum: Runs the Disk Sanitizer erase cycle 3 times.

●

Custom: Allows you to select the desired number of Disk
Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary
hard drive is destroyed permanently.

Diagnostics menu
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Select

To do this

Hard Drive Self-Test options

Run a comprehensive self-test on any hard drive in the system
or on any optional MultiBay hard drive.

Memory Check

Run a comprehensive check on system memory.

Startup Check (select models only)

Verify the system components needed for starting the
computer.
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System Configuration menu
NOTE:

Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language (or press f2)

Change the Computer Setup language.

Boot options

●

Set f9, f10, and f12 delay when starting up.

●

Enable/disable CD-ROM boot.

●

Enable/disable floppy boot.

●

Enable/disable internal network adapter boot and set the
boot mode (PXE or RPL).

●

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

●

Set the Express Boot Popup delay in seconds.

●

Set the boot order.

●

Swap the functions of the fn key and left ctrl key.

●

Enable/disable multiple standard pointing devices at
startup. (To set the computer to support only a single,
usually nonstandard, pointing device at startup, select
Disable.)

●

Enable/disable USB legacy support. When enabled, USB
legacy support allows the following:

Device configurations

◦

Use of a USB keyboard, mouse, and hub in
Computer Setup even when a Windows operating
system is not running.

◦

Startup from bootable USB devices, including a hard
drive, diskette drive, or optical drive connected by a

Computer Setup menus
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USB port to the computer or to an optional docking
device (select models only).
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●

Select a parallel port mode: EPP (Enhanced Parallel
Port), standard, bidirectional, or ECP (Enhanced
Capabilities Port).

●

Enable/disable BIOS DMA data transfers.

●

Enable/disable fan always on while connected to an AC
outlet.

●

Enable/disable Intel Data Execution Prevention or AMD®
PSAE Execution Disable. When enabled, the processor
can disable some virus code execution, which helps to
improve computer security.

●

Enable/disable LAN Power Save. When enabled, saves
power by turning off the LAN when not in use.

●

Enable/disable SATA Native Mode.

●

Enable/disable Dual Core CPU.

●

Enable/disable Secondary Battery Fast Charge.

●

Choose Bit-shift or LBA assisted HDD Translation Mode.

●

Enable/disable Windows direct application launcher.

●

Enable/disable HP Lockout.

Select

To do this

Built-In Device Options

●

Enable/disable embedded WWAN Device Radio.

●

Enable/disable embedded WLAN Device Radio.

●

Enable/disable embedded Bluetooth Device Radio.

●

Enable/disable LAN/WLAN Switching. When enabled,
switches to a WLAN when a LAN is either unavailable or
disconnected.

●

Enable/disable Wake on LAN from Off.

●

Enable/disable the ambient light sensor.

●

Enable/disable the serial port.

●

Enable/disable the parallel port.

●

Enable/disable the flash media reader.

●

Enable/disable the USB port.

Port Options

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.
●

Enable/disable the 1394 port.

●

Enable/disable the cardbus slot.

●

Enable/disable the ExpressCard slot.

●

Enable/disable the infrared port.

●

Enable/disable the optical disk drive.

●

Enable/disable the network controller.

Computer Setup menus

87

6

Specifications

Computer specifications
Metric

U.S.

Length

26.68 cm

10.50 in

Width

35.80 cm

14.10 in

Height (front to rear)

3.23 to 3.58 cm

1.27 to 1.41 in

Weight (equipped with optical drive, hard drive, and battery)

2.45 kg

5.4 lbs

Dimensions

Input power
Operating voltage

19.0 V dc @ 4.74 A – 90 W

Operating current

4.74 A

Temperature
Operating (not writing to optical disc)

0°C to 35°C

32°F to 95°F

Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

-50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating
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0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Metric
Nonoperating

U.S.

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

15.4-inch, WXGA display specifications
Metric

U.S.

Height

20.7 cm

8.15 in

Width

33.1 cm

13.03 in

Diagonal

39.1 cm

15.39 in

Number of colors

Up to 16.8 million

Contrast ratio

200:1 (typical)

Brightness

180 nits (typical)

Dimensions

Pixel resolution
Pitch

0.197 × 0.197 mm

Format

1366 × 768

Configuration

RGB vertical stripe

Backlight

CCFT

Character display

80 × 25

Total power consumption

7.0 W

Viewing angle

+/-40 horizontal, +/–50° vertical (typical)

15.4-inch, WXGA display specifications
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Hard drive specifications
250-GB*

160-GB*

120-GB*

Height

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

Single track

3 ms

3 ms

3 ms

Average

13 ms

13 ms

13 ms

Maximum

24 ms

24 ms

24 ms

Logical blocks

488,397,168

312,560,640

234,420,480

Disc rotational speed

5400 rpm

5400 rpm

5400 rpm

Dimensions

Seek times (typical read, including setting)

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW SuperMulti Double-Layer Combo
Drive with LightScribe specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CDRW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 160 ms

< 190 ms

Cache buffer

2 MB

DVD+R, DVD+RW, DVD-R, DVDRW, DVD-RAM

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD-ROM

10,800 KB/sec

24X CD-R

3,600 KB/sec

24X CD-RW

3,600 KB/sec

8X DVD+R

10,800 KB/sec

8X DVD-R

10,800 KB/sec

8X DVD+RW

10,800 KB/sec

6X DVD-RW

8,100 KB/sec

6X DVD±DUAL

8,100 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

DVD±RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe specifications
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DVD/CD-RW Combo Drive specifications
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CDRW), CD-R, CD-RW, DVD-ROM (DVD-5,
DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW,
DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW

Access time

CD

DVD

Random

< 110 ms

< 130 ms

Cache buffer

2 MB

Data transfer rate
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24X CD-ROM

3,600 KB/sec

8X DVD

3,600 KB/sec

24X CD-R

3,600 KB/sec

24X CD-RW

3,600 KB/sec

Transfer mode

Multiword DMA mode 2
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System DMA specifications
Hardware DMA

System function

DMA0

Not applicable

DMA1*

Not applicable

DMA2*

Not applicable

DMA3

Not applicable

DMA4

Direct memory access controller

DMA5*

Available for ExpressCard

DMA6

Not assigned

DMA7

Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.

System DMA specifications
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System interrupt specifications
Hardware IRQ

System function

IRQ0

System timer

IRQ1

Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2

Cascaded

IRQ3

Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4

COM1

IRQ5*

Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6

Diskette drive

IRQ7*

Parallel port

IRQ8

System CMOS/real-time clock

IRQ9*

Microsoft ACPI-compliant system

IRQ10*

Intel USB UHCI controller—24C2
Intel 82852/82855 GM/GME Graphic Controller
Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11

Intel USB EHCI controller—24CD
Intel USB UHCI controller—24C4
Intel USB UHCI controller—24C7
Intel Pro/Wireless 2200BG
TI OHCI 1394 host controller
TI PCI1410 CardBus controller

IRQ12

Synaptics PS/2 TouchPad

IRQ13

Numeric data processor

IRQ14

Primary IDE channel

IRQ15

Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.
NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial
port may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex)

System function (shipping configuration)

000 - 00F

DMA controller no. 1

010 - 01F

Unused

020 - 021

Interrupt controller no. 1

022 - 024

Opti chipset configuration registers

025 - 03F

Unused

02E - 02F

87334 “Super I/O” configuration for CPU

040 - 05F

Counter/timer registers

044 - 05F

Unused

060

Keyboard controller

061

Port B

062 - 063

Unused

064

Keyboard controller

065 - 06F

Unused

070 - 071

NMI enable/RTC

072 - 07F

Unused

080 - 08F

DMA page registers

090 - 091

Unused

092

Port A

093 - 09F

Unused

0A0 - 0A1

Interrupt controller no. 2

I/O Address (hex)

System Function (shipping configuration)

0A2 - 0BF

Unused

0C0 - 0DF

DMA controller no. 2

0E0 - 0EF

Unused

0F0 - 0F1

Coprocessor busy clear/reset

0F2 - 0FF

Unused

100 - 16F

Unused

170 - 177

Secondary fixed disk controller

178 - 1EF

Unused

1F0 - 1F7

Primary fixed disk controller

1F8 - 200

Unused

201

JoyStick (decoded in ESS1688)

202 - 21F

Unused

System I/O address specifications
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I/O address (hex)

System function (shipping configuration)

220 - 22F

Entertainment audio

230 - 26D

Unused

26E - 26

Unused

278 - 27F

Unused

280 - 2AB

Unused

2A0 - 2A7

Unused

2A8 - 2E7

Unused

2E8 - 2EF

Reserved serial port

2F0 - 2F7

Unused

2F8 - 2FF

Infrared port

300 - 31F

Unused

320 - 36F

Unused

370 - 377

Secondary diskette drive controller

378 - 37F

Parallel port (LPT1/default)

380 - 387

Unused

388 - 38B

FM synthesizer—OPL3

38C - 3AF

Unused

3B0 - 3BB

VGA

3BC - 3BF

Reserved (parallel port/no EPP support)

3C0 - 3DF

VGA

3E0 - 3E1

ExpressCard controller in CPU

3E2 - 3E3

Unused

3E8 - 3EF

Internal modem

3F0 - 3F7

“A” diskette controller

3F8 - 3FF

Serial port (COM1/default)

CF8 - CFB

PCI configuration index register (PCIDIVO-1)

CFC - CFF

PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size

Memory address

System function

640 KB

00000000-0009FFFF

Base memory

128 KB

000A0000-000BFFFF

Video memory

48 KB

000C0000-000CBFFF

Video BIOS

160 KB

000C8000-000E7FFF

Unused

64 KB

000E8000-000FFFFF

System BIOS

15 MB

00100000-00FFFFFF

Extended memory

58 MB

04800000-07FFFFFF

Super extended memory

58 MB

04800000-07FFFFFF

Unused

2 MB

08000000-080FFFFF

Video memory (direct access)

4 GB

08200000-FFFEFFFF

Unused

64 KB

FFFF0000-FFFFFFFF

System BIOS

System memory map specifications
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Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
500131-001.
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Phillips PM2.0×5.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Black

4

5.0 mm

2.0 mm

5.0 mm

Where used:
(1) Two captive screws that secure the hard drive bay cover to the computer (screws are captured on
the cover by C-clips)
(2) One captive screw that secures the WLAN module compartment cover to the computer (screw is
captured on the cover by a C-clip)
(3) One captive screw that secures the memory module compartment cover to the computer (screw is
captured on the cover by a C-clip)

Phillips PM2.0×5.0 captive screw
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Phillips PM2.5×12.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Silver

1

12.0 mm

2.5 mm

5.0 mm

Where used: One captive screw that secures the hard drive to the computer (screw is secured to the
hard drive bracket)
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Phillips PM3.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

4

4.0 mm

3.0 mm

5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive

Phillips PM3.0×4.0 screw 101

Phillips PM2.5×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

4

4.0 mm

2.5 mm

5.0 mm

Where used: 2 screws that secure the WLAN module to the system board

Where used: 2 screws that secure the modem module to the system board
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Slotted Torx ST8M2.5×7.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

17

7.0 mm

2.5 mm

5.0 mm

Where used:
(1) One screw that secures the optical drive to the computer
(2) Two screws that secure the keyboard to the computer

Slotted Torx ST8M2.5×7.0 screw 103

Where used: 4 screws that secure the display assembly to the computer

Where used: 7 screws that secure the top cover to the base enclosure

Where used: 3 screws that secure the top cover to the base enclosure
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Phillips PM2.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Silver

16

4.0 mm

2.0 mm

4.5 mm

Where used: 2 screws that secure the optical drive bracket to the optical drive

Where used: 8 screws that secure the display hinges to the display assembly

Phillips PM2.0×4.0 screw 105

Where used: 2 screws that secure the TouchPad Bracket and TouchPad button board to the top cover

Where used: 2 screws that secure the Blueotooth module to the base enclosure

Where used: 2 screws that secure the ExpressCard assembly to the system board
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Torx T8M2.5×9.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

2

9.0 mm

2.5 mm

5.0 mm

Where used: 2 screws that secure the switch cover to the computer

Torx T8M2.5×9.0 screw 107

Torx T8M2.5×3.0 broadhead screw

Color

Quantity

Length

Thread

Head diameter

Black

3

3.0 mm

2.5 mm

8.0 mm

Where used: 3 screws that secure the switch cover to the computer
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Torx T8M2.5×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

4

4.0 mm

2.5 mm

5.0 mm

Where used: 2 screws that secure the speaker to the computer

Where used: One screw that secures the top cover to the base enclosure

Torx T8M2.5×4.0 screw 109

Where used: One screw that secures the system board to the base enclosure
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Phillips PM2.0×2.0 broadhead screw

Color

Quantity

Length

Thread

Head diameter

Black

3

2.0 mm

2.0 mm

7.0 mm

Where used: 3 screws that secure the top cover to the display enclosure

Phillips PM2.0×2.0 broadhead screw 111

Torx T8M2.5×6.0 screw

Color

Quantity

Length

Thread

Heat width

Black

12

6.0 mm

2.5 mm

5.0 mm

Where used: 8 screws that secure the display bezel to the display assembly

Where used: 4 screws that secure the display panel to the display enclosure
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Phillips PM2.0×6.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

1

6.0 mm

2.0 mm

4.5 mm

Where used: One screw that secures the system board to the base enclosure

Phillips PM2.0×6.0 screw 113

Torx T8M2.0×4.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

2

4.0 mm

2.0 mm

4.5 mm

Where used: 2 screws that secure the optical drive connector board to the base enclosure
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Phillips PM2.5×7.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

1

7.0 mm

2.5 mm

5.0 mm

Where used: One screw that secures the fan to the base enclosure

Phillips PM2.5×7.0 screw 115

Phillips PM2.5×7.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Silver

1

7.0 mm

2.5 mm

5.0 mm

Where used: One captive screw that secures the fan to the base enclosure (screw is secured to the
fan by a C-clip)
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Phillips PM2.5×10.0 captive screw

Color

Quantity

Length

Thread

Head diameter

Silver

4

10.0 mm

2.5 mm

5.0 mm

Where used: 4 captive screws that secure the heat sink to the system board (screws are secured to
the heat sink by C-clips)

Phillips PM2.5×10.0 captive screw 117

Phillips PM2.0×8.0 screw

Color

Quantity

Length

Thread

Head diameter

Black

2

8.0 mm

2.0 mm

4.5 mm

Where used: 2 screws that secure the ExpressCard assembly to the system board
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Backup and recovery in Windows Vista
Overview
To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.
The Backup and Restore Center provides the following options:
●

Backing up individual files and folders

●

Backing up the entire hard drive (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents folder, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
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The screen image is added to the document.
4.
●

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on
the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to back up your entire computer (select models only) or your files.
NOTE: Windows® includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section
in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Click Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.
To recover your information using Startup Repair, follow these steps:
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CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
All files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.
NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the “Using
a Windows Vista operating system DVD (purchased separately)” section in this guide.

3.

Restart the computer, and then press f8 before the Windows operating system loads.

4.

Select Repair your computer.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a search
for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you
have created and any software installed on the computer are permanently removed. The f11 recovery
tool reinstalls the operating system and HP programs and drivers that were installed at the factory.
Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.
NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system
DVD to reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows Vista operating system
DVD, go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.
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CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows Vista operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.
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Backup and Recovery in Windows XP
Overview
To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.
Windows provides the following options:
●

Backing up individual files and folders

●

Backing up all files and folders

●

Scheduling automatic backups

●

Creating recovery points

●

Recovering information

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:
●

Store personal files in the My Documents folder, and back it up periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a.

Display the screen you want to save.

b.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, click Edit > Paste.
The screen image is added to the document.

d.

Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
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NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Click Start > All Programs > Accessories > System Tools > Backup.

2.

Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

●

Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1.

If possible, back up all personal files.

2.

Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.

3.

Click Restore files and settings, and then click Next.

4.

Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.
To recover your operating system and programs, follow these steps:
1.

If possible, back up all personal files.

2.

Insert the Operating System disc into the optical drive.

3.

Shut down the computer.

4.

Turn on the computer.

5.

Follow the on-screen instructions to install the operating system.

6.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7.

Follow the on-screen instructions to install the drivers and programs.
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Connector pin assignments

Audio-out (headphone)

Pin

Signal

1

Audio out, left channel

2

Audio out, right channel

3

Ground

Audio-in (microphone)

Pin

Signal

1

Audio signal in

2

Audio signal in

3

Ground

126 Chapter 9 Connector pin assignments

External monitor

Pin

Signal

1

Red analog

2

Green analog

3

Blue analog

4

Not connected

5

Ground

6

Ground analog

7

Ground analog

8

Ground analog

9

+5 VDC

10

Ground

11

Monitor detect

12

DDC 2B data

13

Horizontal sync

14

Vertical sync

15

DDC 2B clock
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RJ-11 (modem)

Pin

Signal

1

Unused

2

Tip

3

Ring

4

Unused

5

Unused

6

Unused
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RJ-45 (network)

Pin

Signal

1

Transmit +

2

Transmit -

3

Receive +

4

Unused

5

Unused

6

Receive -

7

Unused

8

Unused

Universal Serial Bus

Pin

Signal

1

+5 VDC

2

Data -

3

Data +

4

Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Index

A
AC adapter, spare part
number 24, 25
antenna, disconnecting 44
antennae 13
audio, product description 3
audio-in jack
location 9
pin assignments 126
audio-out jack
location 9
pin assignments 126
B
backing up files 120
backing up files and folders 124
Backup and Restore
Center 120, 121
base enclosure, spare part
number 18, 28
battery
location 12
removal 39
spare part number 18
spare part numbers 30, 39
battery bay 12
battery latches 12
battery light 11
Bluetooth module
removal 65
spare part numbers 17, 25,
26, 65
Bluetooth module cable, spare part
number 22
boot options 85
boot order 85
bottom components 12
button components 7
buttons
power 7

138 Index

TouchPad 6
wireless 7
C
Cable Kit
contents 22
spare part number 20, 22,
26
cables, service considerations 32
caps lock light 7
carrying case, spare part
number 24
chipset, product description 1
CMOS clearing 36
components
bottom 12
buttons 7
front 9
keys 8
left-side 11
lights 7
pointing devices 6
right-side 10
speaker 7
top 6
TouchPad 6
computer feet
locations 38
spare part number 38
Computer Setup
accessing 81
Diagnostics menu 84
File menu 83
navigating and selecting 82
restoring factory settings 82
Security menu 84
System Configuration
menu 85
using 82
computer specifications 88

connectors
power 11
service considerations 32
creating a backup 120
D
Diagnostics menu 84
discs
Driver Recovery 125
Operating System 125
Disk Sanitizer 84
diskette drive
precautions 32
product description 3
spare part number 24
display assembly
removal 55
spare part numbers 16, 28,
55
display bezel
removal 57
spare part number 57
Display Cable Kit, spare part
number 16, 30, 55
display component recycling 132
display enclosure, spare part
number 16, 29
display hinge
removal 58
spare part number 16, 27,
59
display inverter
removal 57
spare part number 16, 26,
58
display lid switch module
removal 54
spare part number 22

display panel
product description 1
removal 58
display specifications 89
DriveLock password 84
Driver Recovery disc 125
drives
boot order 85
preventing damage 32
DVD-ROM Drive
precautions 32
removal 46
spare part number 20, 23,
30, 46
DVD/CD-RW Combo Drive
precautions 32
removal 46
spare part number 20, 23,
30, 46
specifications 92
DVD±RW and CD-RW SuperMulti
Double-Layer Combo Drive with
LightScribe
precautions 32
removal 46
spare part numbers 20, 23,
30, 46
specifications 91
E
electrostatic discharge 33
esc key 8
Ethernet, product description 3
Execution Disable 86
ExpressCard assembly
removal 79
spare part numbers 17, 28,
29, 66
ExpressCard slot 11
ExpressCard slot protective insert
illustrated 21
external media cards, product
description 3
external monitor port
location 11
pin assignments 127
F
f11 recovery 122

fan
removal 70
spare part number 17, 25,
70
feet
locations 38
spare part number 38
File menu 83
files and folders
backing up 124
recovering 125
fn key 8
front components 9
function keys 8
G
graphics, product description
grounding equipment and
methods 35

1

H
hard drive
location 12
precautions 32
product description 2
removal 40
spare part numbers 20, 23,
29, 40
specifications 90
hard drive bay 12
hard drive bay cover
illustrated 21
removal 40
hard drive bracket, removal 41
hard drive recovery 122
hard drive test 84
headphone jack
location 9
pin assignments 126
heat sink
removal 72
spare part number 18, 26,
66, 72
hinge
removal 58
spare part number 16, 27,
59
I
I/O address specifications 95
interrupt specifications 94

J
jacks
audio-in 9
audio-out 9
headphone 9
microphone 9
modem 11
network 11
RJ-11 11
RJ-45 11
K
key components 8
keyboard
product description 4
removal 50
spare part numbers 16, 28,
50
keypad keys 8
keys
esc 8
fn 8
function 8
keypad 8
Windows applications 8
Windows logo 8
L
LAN Power Save 86
language, changing in Computer
Setup 85
left-side components 11
legacy support, USB 81, 85
light components 7
lights
battery 11
caps lock 7
power 8
wireless 7
Logo Kit, spare part number 24,
29
M
mass storage devices, spare part
numbers 23
memory check 84
memory map specifications 97
memory module
product description 1
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removal 45
spare part numbers 20, 29,
45
memory module compartment 12
memory module compartment
cover
illustrated 21
removal 45
microphone jack
location 9
pin assignments 126
modem jack
location 11
pin assignments 128
modem module
product description 3
removal 76
spare part number 18, 27,
76
monitor port
location 11
pin assignments 127
N
network jack
location 11
pin assignments 129
O
Operating System disc 125
operating system, product
description 4
optical drive
location 10
precautions 32
product description 2
removal 46
spare part numbers 20, 23,
46
specifications 91, 92
optical drive bay protective insert
not illustrated 21
optical drive connector board
removal 69
spare part number 17, 26,
28, 46, 69
P
packing guidelines 34
parallel port mode 86
password clearing 36
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passwords 84
pin assignments
audio-in jack 126
audio-out jack 126
external monitor port 127
headphone jack 126
microphone jack 126
modem jack 128
monitor port 127
network jack 129
RJ-11 128
RJ-45 jack 129
Universal Serial Bus (USB)
port 129
plastic parts 31
Plastics Kit
contents 21
spare part number 17, 21,
26
pointing device
components 6
illustrated 6
product description 4
pointing device components
TouchPad 6
TouchPad buttons 6
TouchPad scroll zone 6
ports
external monitor 11
monitor 11
product description 4
Universal Serial Bus (USB) 11
power button 7
power connector 11
power cord
set requirements 130
spare part numbers 24, 27
power light 8
power requirements, product
description 4
power-on password 84
processor
product description 1
removal 74
spare part number 30
spare part numbers 18, 29,
74
product description
audio 3
chipset 1

diskette drive 3
display panel 1
Ethernet 3
external media cards 3
graphics 1
hard drives 2
keyboard 4
memory module 1
modem module 3
operating system 4
optical drives 2
pointing devices 4
ports 4
power requirements 4
processors 1
security 4
serviceability 5
wireless 3
R
recovering information 121, 125
recovery partition 122
removal/replacement
preliminaries 31
procedures 37
restoring the hard drive 122
right-side components 10
RJ-11 jack
location 11
pin assignments 128
RJ-11 jack cable
release 67
spare part number 22
RJ-45 jack
location 11
pin assignments 129
RTC battery
removal 78
spare part number 18, 26,
78
Rubber Kit, spare part number 29
S
Screw Kit
contents 98
spare part number 25, 29
screw listing 98
SD Card Reader 9
security cable slot 10
Security menu 84

security, product description 4
serial number 14, 37
service considerations 31
serviceability, product
description 5
setup utility
Diagnostics menu 84
File menu 83
Security menu 84
System Configuration
menu 85
speaker
location 8
removal 53
spare part number 17, 26,
53
specifications
computer 88
display 89
DVD/CD-RW Combo Drive 92
DVD±RW and CD-RW
SuperMulti Double-Layer
Combo Drive with
LightScribe 91
hard drive 90
I/O addresses 95
interrupts 94
memory map 97
optical drive 91, 92
system DMA 93
startup check 84
static-shielding materials 35
stringent security 84
switch cover
removal 48
spare part number 16, 28,
48
system board
removal 66
spare part numbers 17, 28,
29, 66
System Configuration menu 85
system DMA 93
system fan 86
system information 83
system memory map 97
T
thermal material, replacement 73
tools required 31

top components 6
top cover
removal 60
spare part number 17, 28,
60
TouchPad
spare part number 17, 28
TouchPad board
removal 63
spare part number 63
TouchPad button board
removal 63
spare part number 17, 28,
63
TouchPad buttons 6
TouchPad components 6
TouchPad scroll zone 6
transporting guidelines 34
U
unknown password 36
USB legacy support 81, 85
USB port
location 11
pin assignments 129
V
vents 11, 12
W
Windows applications key 8
Windows Backup utility 124, 125
Windows logo key 8
Windows recovery 125
Windows Vista operating system
DVD 122
wireless antenna,
disconnecting 44
wireless antennae 13
wireless button 7
wireless light 7
wireless, product description 3
WLAN module
removal 42
spare part numbers 18, 26,
42
WLAN module compartment 12
WLAN module compartment cover
illustrated 21
removal 44
workstation guidelines 34
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